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1 はじめに

「ASCET 製品ファミリ」は、組み込みソフトウェアシステムのファンクション開発
とソフトウェア開発のための革新的なソリューションを提供するものです。各

ASCET 製品は、新しい独自のアプローチによって、モデリング、コード生成、シ
ミュレーション実験、といった開発工程の各段階を強力にサポートするので、品質
向上や開発サイクルの短縮、さらにコスト低減を実現できます。

本書は、ASCET 製品のインストール方法、およびそれに関連する情報を説明するも
のです。製品の機能や操作方法などについての情報は、各製品のマニュアルやオン
ラインヘルプをご参照ください。

1.1 本書について

1.1.1 本書の構成

ASCET インストールガイドは、以下の章で構成されています。

• 「はじめに」（本章）

本書に関する一般的な説明です。

• 「プログラムのインストール」

この章は、PC またはネットワーク上に ASCET をインストールし、ASCET プ
ログラムのメンテナンスやアンインストールを行うすべてのユーザー、およ
び ASCET をファイルサーバーに供給してネットワーク経由のインストールを
行うシステム管理者を対象としています。ここには、製品の内容、スタンド
アロンインスタレーションとネットワークインスタレーションに必要なハー
ドウェアやソフトウェアの要件、インストールの準備作業、インストールと
アンインストールの手順も紹介されています。

• 「ソフトウェアのライセンス管理」

ASCET を使用するためのライセンスについての情報（ライセンスファイルの
入手方法、ライセンスの借用方法など）が説明されています。

• 「お問い合わせ先」

ETAS の各支社の連絡先です。

1.1.2 本書の使用法

表現について

ユーザーが実行するすべてのアクションは、いわゆる “Use-Case” 形式で記述され
ています。つまり以下に示すように、操作を行う目標がタイトルとして最初に簡潔
に定義され（例：「新しいコンポーネントを作成する」、「エレメントの名前を変更す
る」）、その下に、その目標を実現するために必要な操作手順が列挙され、必要に応
じて ASCET のウィンドウやダイアログボックスのスクリーンショットが添付されて
います。
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目標の定義：

前置き ...

• 手順 1

手順 1 についての説明 ...

• 手順 2

手順 2 についての説明 ...

• 手順 3

手順 3 についての説明 ...

まとめ ...

具体例：

新しいファイルを作成する：

新しいファイルを作成する際は、他のファイルをすべて閉じておきます。

• File → New を選択します。

“Create file” ダイアログボックスが開きます。

• 新しいファイルの名前を、“File name” フィールドに
入力します。

ファイル名は 8 文字以内でなければなりません。

• OK をクリックします。

新しいファイルが作成され、ユーザーが指定した名前で保存されます。このファイ
ルを使用して以降の操作を行います。

表記上の規則

本書は以下の規則に従って表記されています。

表記例 説明

File → Exit を選択して、... メニューコマンドは、青の太字で表記し
ます。

OK をクリックして、... ユーザーインターフェース上のボタン名
は、青の太字で表記します。

<Ctrl> を押して、... キーボードの各キーは、< > で囲んで表
記します。

“Open File” ダイアログボックスが
開きます。

プログラムウィンドウ、ダイアログボッ
クス、入力フィールド等のタイトル
は、“ ” で囲んで表記します。

setup.exeファイルを選択します。 リストボックス、プログラムコード、
ファイル名、パス名等のテキスト文字列
は、Courierフォントで表記します。

論理型のデータから算術型のデータへ

の変換はできません。

注意すべき個所、または新出の用語は太
字 、あるいは「 」で囲んで表記されま
す。

OSEK グループ（ÜííéWLLïïïKçëÉâJ
îÇñKçêÖL を参照してください）はさま
ざまな標準規格を策定しています。

インターネットへのリンクは、\\\\ で表
記されています。
はじめに



特に重要な注意事項は、以下のように表記されています。

また PDF 文書において、索引、および他の部分を参照する個所（例：「xx を参照し
てください」の中の「xx」の部分）については、その参照先へのリンクが設けられ
ているので、必要な参照個所を素早く見つけることができます。

注記

ユーザー向けの重要な注意事項
はじめに 7
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2 プログラムのインストール

この章は、PC またはネットワーク上に ASCET をインストールし、ASCET プログラ
ムのメンテナンスやアンインストールを行うすべてのユーザー、および ASCET を
ファイルサーバに供給してネットワーク経由のインストールを行うシステム管理者
を対象としています。ここには、製品の内容、スタンドアロンインスタレーション
とネットワークインスタレーションに必要なハードウェアやソフトウェアの条件、
およびインストールに必要な準備について、重要な情報が記載されています。また、

ASCET のインストールとアンインストールの手順も紹介しています。

2.1 準備

インストールを行う際は、まず製品の内容に不足がないこと、またお手持ちのコン
ピュータがシステム要件を満たしていることを確認してください。使用するオペ
レーティングシステムとネットワーク接続によっては、インストールを行うために
必要なユーザー特権を持っていることを確認する必要があります。

2.1.1 製品の内容

ASCET は、以下のアイテムで構成されます。

• ASCET インストールディスク

－ ASCET のインストールプログラム

－ ASCET マニュアルおよび ETAS ハードウェアのドキュメント（PDF ファイ
ル、開くためには Acrobat Reader が必要です）

－ エンドユーザー向け FLEXnet ライセンスユーザーズガイド（PDF ファイ
ル）

また、ASCET を使用するには、ライセンス契約に基づいて発行されたライセンス
ファイルが必要です。このファイルは、システム管理者の方から、または ETAS ホー
ムページのライセンスポータルサイト（URL は製品ご購入時のエンタイトルメント
レターに記載されています）から入手できます。ライセンスファイルのお申し込み
時には、受注プロセスにおいて ETAS から発行された「アクティベーション番号」が
必要です。詳しくは第 3 章 「ソフトウェアのライセンス管理」 （35 ページ）を参照
してください。

2.1.2 システム要件

ASCET を使用する PC は、以下の条件を満足している必要があります。

• 1.5 GHz Pentium PC （推奨： 2 GHz 以上）

• Windows® 7（32 ビットまたは 64 ビット） 、Windows® Vista（x86） 、
Windows® XP（x86） + SP2 以降

（推奨： Windows® XP（x86） + SP3）

• 1 GB RAM （推奨： 4 GB）

• 空き容量が 3 GB 以上（プログラムデータ分を含まず）のハードディスク 
（推奨： 4 GB 以上）

• DVD-ROM ドライブ

• グラフィック： 1024×768 以上の解像度 （推奨： 1600 × 1200）、32 MB の

RAM （推奨： 128 MB）、16 ビットカラー （推奨： 32 ビット）、DirectX 7 
（推奨： DirectX 7 以上、ハードウェアアクセラレータ搭載）
プログラムのインストール 9
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2.1.3 インストールと運用に必要なユーザー特権

インストールに必要なユーザー特権 :

ASCET を PC にインストールするには、管理者のユーザー特権が必要です。ない場
合は、システム管理者の方にお問い合わせください。

運用に必要なユーザー特権 :

ASCET を使用するユーザーは、管理者から “ スケジューリング優先順位の繰り上げ

” という特権を受ける必要があります。この特権は、ユーザーマネージャーを使用
して設定します。

推奨： 一般的には、以下のようにして “ スケジューリング優先順位の繰り上げ ” 特
権をローカルの “Users” グループに設定してください。

Windows XP でユーザー特権 “ スケジューリング優先順位の繰り上げ ” を割り当て
る：

• Windows のスタートメニューから、設定 → コント
ロールパネル → 管理ツール → ローカルセキュリティ
ポリシー を選択します。

• ローカルポリシー → ユーザー権利の割り当て に含ま
れる “ スケジューリング優先順位の繰り上げ ” をダブ
ルクリックします。

“ スケジューリング優先順位の繰り上げ ” ダイアログ
ボックスが開きます。

• ユーザーまたはグループの追加 ボタンをクリックしま
す。

“ ユーザーまたはグループの選択 ” ダイアログボック
スが開きます。

• 場所 ボタンをクリックします。

“ 場所 ” ダイアログボックスが開きます。

• ローカルコンピュータを選択し、OK をクリックして

“ 場所 ” ダイアログボックスを閉じます。

• “ ユーザーまたはグループの選択 ” ダイアログボック
スで、詳細設定 ボタンをクリックして、自動検索機能
を有効にします。

• 今すぐ検索 ボタンをクリックして、ローカルコン
ピュータに登録されているユーザーのリストを表示し
ます。

• “ 名前（RDN）” のカラムから、スケジューリング優
先度の繰り上げの権利を割り当てたいユーザーまたは
グループを選択します。

• OK ボタンをクリックして確定します。

• OK ボタンで “ ユーザーまたはグループの選択 ” ダイ
アログボックスを閉じます。

• OK ボタンで “ スケジューリング優先順位の繰り上げ

” ダイアログボックスを閉じます。

• ローカルセキュリティ設定を終了します。

注記

下記の設定を行うには管理者権限が必要です。
プログラムのインストール



Windows Vista ／ Windows 7 でユーザー特権 “ スケジューリング優先順位の繰
り上げ ” を割り当てる：

• Windows Vista の場合：

－ Windows の スタート メニューから、 コントロー
ルパネル → システムとメンテナンス → 管理ツー
ル → ローカルセキュリティポリシー を選択しま
す。

• Windows 7 の場合：

－ Windows の スタート メニューから、 コントロー
ルパネル → 管理ツール → ローカルセキュリティ
ポリシー を選択します。

• ローカルポリシー → ユーザー権利の割り当て に含ま
れる “ スケジューリング優先順位の繰り上げ ” をダブ
ルクリックします。

“ スケジューリング優先順位の繰り上げ ” ダイアログ
ボックスが開きます。

• ユーザーまたはグループの追加 ボタンをクリックしま
す。

“ ユーザー、コンピュータまたはグループの選択 ” ダ
イアログボックスが開きます。

• 場所 ボタンをクリックします。

“ 場所 ” ダイアログボックスが開きます。

• ローカルコンピュータを選択し、OK をクリックして

“ 場所 ” ダイアログボックスを閉じます。

“ ユーザー、コンピュータまたはグループの選択 ” ダ
イアログボックスの名前が “ ユーザーまたはグループ
の選択 ” に変わります。

• “ ユーザーまたはグループの選択 ” ダイアログボック
スで、詳細設定 ボタンをクリックして、自動検索機能
を有効にします。

“ ユーザーまたはグループの選択 ” ダイアログボック
スが開きます。

• 今すぐ検索 ボタンをクリックして、ローカルコン
ピュータに登録されているユーザーのリストを表示し
ます。

• “ 名前（RDN）” のカラムから、スケジューリング優
先度の繰り上げの権利を割り当てたいユーザーまたは
グループを選択します。

• OK ボタンをクリックして確定します。

• OK ボタンで “ ユーザーまたはグループの選択 ” ダイ
アログボックスを閉じます。

• OK ボタンで “ スケジューリング優先順位の繰り上げ

” ダイアログボックスを閉じます。

• ローカルセキュリティ設定を終了します。
プログラムのインストール 11
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2.2 ディスクからのインストール

いずれかのアドオン製品（ASCET-MD、ASCET-RP、ASCET-SE、ASCET-SCM）をイ
ンストールする際は、まず最初に ASCET の基本システムをインストールする必要が
あります。また ASCET-SCM をインストールするには、先に ASCET-MD、ASCET-
RP、ASCET-SE のいずれかをインストールする必要があります。

インストールの方法は、DVD から行う場合もネットワークドライブから行う場合も
同様です。

2.2.1 項で基本システムのインストール方法を詳しく説明します。アドオン製品のイ
ンストール方法は 2.2.2 項に簡単に説明されていますが、より詳しい情報が必要な
場合は、各アドオン製品のマニュアルやリリースノートをご覧ください。

2.2.3 項には、特殊なインストール条件（「インストールを中止する：」、「既存のプ
ログラムバージョンに上書きしてインストールする：」など）について説明されて
います。またコマンドラインからインストールを実行する場合は 2.2.4 項の情報を
参照してください。

2.2.1 ASCET 基本システムのインストール

ASCET のインストールを開始する：

• インストールディスクを PC のディスクドライブに挿
入します。

• インストールプログラムが自動的に起動しない場合は

start.exeをダブルクリックします。

インスタレーションダイアログボックスが開きます。

• Main というリンクをクリックします。
プログラムのインストール



• ASCET というリンクをクリックします。

ASCET 基本システムのインストール処理が開始され
ます。

ライセンス契約の内容を確認する：

• “EULA” というタイトルのダイアログボックスが開
き、ライセンス契約の内容が表示されるので、内容に
同意いただける場合は、Accept オプションをクリッ
クしてオンにしてください。

• OK をクリックして確定します。

• 画面に表示される指示に従って先に進みます。

ダイアログボックス内に設定した内容を確定するに
は、Next ボタンをクリックして次のダイアログボッ
クスに進みます。Back ボタンをクリックすると前の
ダイアログボックスに戻り、また Cancel をクリック
するとインストールが中止されます。

ASCET を登録する：

• 以下のダイアログボックスに、ユーザーの個人情報を
入力します。

• Next ボタンをクリックします。

注記

ASCET-MD やその他の ASCET 製品（ASCET-DIFF 以
外）をインストールするには、あらかじめ ASCET 基本
システムをインストールしておく必要があります。
プログラムのインストール 13
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ASCET の登録が終わると、インストール先のターゲットディレクトリを指定するよ
うに要求されます。

ASCET のパスを指定する：

プログラムファイルとプログラムデータは別のディレクトリに格納されます。後で
プログラムをアンインストールしたり更新すると、プログラムファイルだけが削除
または上書きされます。プログラムデータはそのまま残り、継続して使用可能です。
プログラムデータには以下のデータが含まれます。

• データベース

• ユーザープロファイル

• デフォルトのディレクトリを変更したい場合には、

Browse ボタンをクリックします。

• パス選択ダイアログボックスで、希望のディレクトリ
を選択します。

存在しないディレクトリを指定すると、インスタレー
ションルーチンがそのディレクトリを自動的に作成し
ます。

• Next ボタンをクリックします。

注記

ASCET のインスタレーションディレクトリのパスには、スペース文字を含めるこ
とができます。ただしその際は、ASCET と共に使用する外部ツールも空白文字を
含むパス名をサポートしている必要がありますので、確認してからインストール
を行ってください。

ASCET を Windows 7 で使用する場合、ASCET は実行中にインスタレーション
ディレクトリにファイルを書き込むため、ユーザーの書き込みアクセスが可能な
場所にインストールするようにしてください。たとえば、Program Files以外
の場所をお勧めします。
プログラムのインストール



スタートメニューに表示される ASCET フォルダ名を指定する：

• デフォルトのフォルダ名を有効にします。

または

• 別のフォルダ名を指定します。

• Next ボタンをクリックします。

“Ready to install” ダイアログボックスが開き、ログ
ファイルと一時ファイルの保存先が表示されます。こ
れらのパスは変更できません。

ASCET をインストールする：

• “Ready to Install” ダイアログボックスで Next をク
リックして、インストールを開始します。

プログラムファイルがコピーされます。コピーの進捗
状況は、棒グラフによって表されます。

必要に応じて ETAS ライセンスマネージャがインス
トールされます。

最後に “Installation complete” というダイアログボッ
クスが開きます。

• Finish をクリックします。

インストールが完了します。

インストールが完了すると、指定した名前の ASCET フォルダが Windows のスター

トメニューに表示され、その中に以下のアイテムが表示されます。

• ASCET Help

ASCET オンラインヘルプを開きます。

• ASCET Uninstall

アンインストールルーチンを起動します（2.5 項を参照してください）。

注記

次のステップで、実際のインストール処理が開始されます。
プログラムのインストール 15
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• ASCET V6.1

ASCET プログラムを起動します。

• AS Editor

AS エディタを起動します（詳しくは ASCET オンラインヘルプをご参照くだ
さい）。

• Online manuals

オンラインマニュアルがインストールされている場合は、ここからマニュア
ルディレクトリ ETAS¥ETASManualsを開くことができます。各マニュア
ルはこのディレクトリ下のサブディレクトリに保存されています。

• ReadMe

ASCET V6.1 についての最新情報が収められているファイルを開きます。

ETAS ライセンスマネージャについては、Windows スタートメニューの ETAS フォ
ルダ内に License Management という独立したフォルダが作成されます。このフォ
ルダには ETAS License Manager というエントリのみが含まれます。

ASCET のインスタレーションディレクトリの下の exportディレクトリ内にはいく
つかのサンプルファイル（*.expまたは *.aml）がコピーされていて、これらの
ファイルを ASCET データベースにインポートすることができます。

• ETAS_System_Library.*と ETAS_System_CT_Library.* － PT1
エレメントなどの基本モデリングブロックやその他の基本フィルタエレメン
ト、積分器などが含まれる ETAS システムライブラリです。

• ETAS_MBFS_Library.* － ASAM AE MBFS 規格1 で定義されたブロック
のサブセットが含まれる ETAS システムライブラリです。

• Tutorial.* － ETAS チュートリアル

• Tutorial AUTOSAR UG.* － AUTOSAR チュートリアル

1. ÜííéWLLïïïK~ë~ãKåÉí → Standards → ASAM Automotive Electronics を参照してくださ
い。

注記

ASCET を起動するには、ASCET-MD、ASCET-RP、ASCET-SE のいずれかをインス
トールする必要があります。
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2.2.2 ASCET-MD およびその他の ASCET 製品のインストール

基本システムをインストールした後は、ASCET-MD やその他のアドオン製品をイン
ストールすることができます。

ASCET アドオン製品をインストールする：

• 再度インタレーションダイアログボックスを開き、

Main リンクをクリックします。

• ASCET-MD（またはその他の ASCET 製品）のリンク
をクリックします。

• 画面の指示に従ってインストールを行います。

選択された製品がインストールされます。

ASCET-RP をインストールすると、Windows スタートメニューの ETAS のプログラ
ムグループに ETAS Network settings というエントリが追加されます。このエント
リから、ETAS ネットワーク設定のためのプログラムが起動します。

2.2.3 特殊な条件でのインストール

インストールの中止

インストールの途中でインストールを中止するには、以下のように操作してくださ
い。

注記

ASCET-MD やその他の ASCET 製品（ASCET-DIFF 以
外）をインストールするには、あらかじめ ASCET 基本
システムをインストールしておく必要があります。
また、ASCET-SCM を使用するには、あらかじめ

ASCET-MD、ASCET-RP、ASCET-SE のいずれかがイン
ストールされている必要があります。
プログラムのインストール 17



18
インストールを中止する：

• 操作中のダイアログボックスで、Cancel ボタンをク
リックします。

• 元のダイアログに戻るには、Resume をクリックしま
す。

• セットアッププログラムを終了してインストールを中
止するには、Exit Setup ボタンをクリックします。

• OK をクリックすると、インストールが中止されま
す。

旧バージョンに「上書きインストール」を行う

インストールしようとするソフトウェアの旧バージョンがすでにインストールされ
ている場合、または指定されたディレクトリに別のソフトウェアがすでにインス
トールされている場合、その旨を通知するメッセージが表示されます。たとえば旧
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バージョンの ASCET がインストールされている PC に新しい ASCET をインストー
ルしようとすると、以下の例のようなメッセージが表示されます。その場合は以下
のように操作してください。

既存のプログラムバージョンに上書きしてインストールする：

• 表示されたメッセージをよく読んでください。

この例では、指定のディレクトリに旧バージョンがす
でにインストールされていることが示されています。
以降の処理を続行すると、これらのファイルは上書き
されます。

• 他のディレクトリにインストールするには、Back ボ
タンをクリックします。

• 既存のファイルに上書きしてよければ、Yes, 
overwrite it ボタンをクリックします。

• 上記の確認メッセージが表示されるので、Yes, 
overwrite it! をクリックして確定します。

上書きせずに元のダイアログボックスに戻るには No
をクリックします。

既存のディレクトリに「上書きインストール」を行う

指定されたディレクトリがすでに存在していて、そこに ASCET が完全にインストー
ルされていない場合、その旨を通知するメッセージが表示されます。このような状
況は、前回のインストール処理が途中でキャンセルされた場合などに発生します。
その場合は以下のように操作してください。
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既存のディレクトリに上書きする：

• 表示されたメッセージをよく読んでください。

この例では、指定されたディレクトリがすでに存在し
ていることを示しています。

• 他のディレクトリにインストールするには、Back ボ
タンをクリックします。

• 既存のディレクトリに上書きしてよければ、Yes, 
delete it ボタンをクリックします。

• 確認メッセージが表示されるので、Yes, delete all! 
をクリックして確定します。

ASCET がインストールされて、既存のファイルはす
べて削除されます。

上書きを行わずに前のダイアログボックスに戻るには 
No をクリックします。

管理者権限がない場合

Windows にログオンした時のユーザー名に管理者権限が与えられていない場合、以
下のメッセージボックスが開きます。ASCET のインストールを行うには管理者権限
が必要であるため、メッセージを確認した後は、インストール処理は中断されます。
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管理者権限なしでインストールを実行しようとした場合：

• メッセージを確認して OK をクリックします。

インストールは中断されます。

• システム管理者の方に問い合わせてください。

• 必要な権限を取得した後、再度インストールを行って
ください。

2.2.4 コマンドラインからのインストール

インストールをコマンドラインから実行する場合は、引数を使用してインストール
処理をカスタマイズすることができます。

/? または /h

ダイアログボックスが開き、有効なコマンドライン引数が表示されます。

/silent または /s

「サイレントモード」でインストールを行います。このモードにおいてはユー
ザーの介入を必要とするダイアログボックスが開きません。通常のインス
トールにおいてダイアログボックスで入力される情報の代わりに、デフォル
ト値、または install.iniから読み込まれた値が使用されます。エラー
メッセージも表示されません。

サイレントインストールの処理は、バックグラウンドプロセスによって実行
されます。インストール中は Windows のシステムトレイにアイコンが表示
されますが、ユーザーがこのプロセスに介入することはできません。

インスタレーションディレクトリ内の silent.logというファイルにイン
ストールログが記録されます。このファイルは *.iniと同じ形式で、サイ
レントモードでインストールされた各 ASCET 製品ごとにセクションが作成さ
れます。インストール実行中は、その製品のセクションに以下の行が記録さ
れます。

install=in progress

インストールが正常に終了すると、その行は以下のように書き変わります。

install=successfully finished

インストール後に PC の再起動が必要な場合は、install.ini内に所定の
エントリ1 で指定されていない限り自動的に再起動が行われます。以下の行
が所定のセクションに追加されます。

need reboot=yes

注記

/silentは、コマンドラインの最初の引数として使用してください。他の引数
が先に指定されると、/silentは無効となります。

1. [SilentInstallation]
;prevents a silent installation from rebooting when
;set to "Suppress"
Restart=Suppres 
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/basic

「ベーシックモード」でのインストールを行います。このモードにおいては、
ライセンス契約についての情報が表示される “EULA” というタイトルのダイ
アログボックスを除き、ユーザーの介入を必要とするダイアログボックスが
開きません。サイレントモードと同様のインストールが行われますが、ベー
シックモードにおいては進捗バーとエラーメッセージが表示され、ログファ
イルは生成されません。

/ini="<MyPath>\<IniFileName>.ini"

デフォルト状態において、インストール時にはインスタレーションディレク
トリに保存されている install.iniファイルが使用されます。しかし、1
つのネットワークドライブから複数のユーザーが ASCET 製品をインストール
するには、使用環境に応じて異なる *.iniファイルが必要となる場合があ
ります。そのような場合は、以下のようにしてファイルのパスを指定します。

インスタレーションディレクトリ外にある*.iniファイルを使用する場合： 
/ini="<MyPath>¥<IniFileName>.ini"

インスタレーションディレクトリ内にある*.iniファイルを使用する場合： 
/ini=".¥<IniFileName>.ini"

2.3 ネットワーク経由のインストール

DVD からだけでなく、PC 上のネットワークドライブからも ASCET をインストール
できます。

ネットワークインスタレーションには、PC に実際にインストールする前にあらかじ
めインストールオプションを設定しておくことができるという利点があります

（2.3.2 を参照してください）。

2.3.1 ネットワークドライブからの ASCET 製品のインストール

ネットワークドライブからインストールを行う場合も、ディスクから行う場合と同
じダイアログボックスが開きます（12 ページの「ディスクからのインストール」を
参照）。

ネットワークドライブからのインストールを行うには、まず以下のように、インス
トールに必要なファイルをインストールディスクからネットワークドライブ上にコ
ピーしておく必要があります。 

ファイルをネットワークサーバーにコピーする：

• 任意のネットワークドライブ上にソースディレクトリ
を作成します。

• インストールディスクの全データをソースディレクト
リにコピーします。

ASCET のインストールを開始する：

• ネットワークドライブ上にあるファイル（例 : 
ASCET.exe、ASCET-MD.exe）をダブルクリック
します。

注記

ASCET 製品の中には、install.ini内に環境変数を定義できたりサイレント／
ベーシックモードを制御するための設定を定義しておく必要があるものがありま
す。詳しくは各製品のドキュメントを参照してください。
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• インタレーションダイアログボックの指示に従ってイ
ンストールを行います。

2.3.2 ネットワークインスタレーションのカスタマイズ

ユーザーが自分のワークステーションに ASCET をインストールする前に、ASCET
のデフォルトのインストールオプションをカスタマイズしておくことができます。

ネットワークインスタレーションの場合、以下のことが可能となります。

• ディレクトリなどのデフォルト設定を変更しておくことにより、インスタ
レーションダイアログをカスタマイズできます（23 ページ「インスタレー
ションダイアログのカスタマイズ」 参照）。

• 1 つのインストールが終了した後、続けて最大 10 個まで他のソフトウェアの
インストール処理を行うことができます（24 ページの「インストールの連続
実行」を参照してください）。

• ネットワークインストールログファイルの格納位置を指定できます（24 ペー
ジの「インストール情報のロギング」を参照してください）。

• ASCET がライセンスにアクセスする方法を指定できます（25 ページ「ライ
センスの運用方法」 参照）。

• ASCET のインストールを、ユーザーの介入なしにバックグラウンドで完全に
自動実行できます（26 ページ「自動インストール」 参照）。

• カスタマイズしたファイルで製品のデータディレクトリ（デフォルト設定は

[drive]:¥ETASdata¥ASCET6.1¥...）内のファイルを上書きしたり、既
存のディレクトリにファイルが追加されるように指定できます（27 ページ

「ASCET ファイルのカスタマイズ」 参照）。

インスタレーションダイアログのカスタマイズ

大規模な部署内で多くのユーザーがネットワークインスタレーションを行うような
場合、インストールに使用されるオプション情報のデフォルト設定をあらかじめカ
スタマイズしておいて、各 PC に同じ条件でインストールが行われるようにする必要
が生じる場合があります。このようなカスタマイズは、install.iniコンフィ
ギュレーションファイルを使えば可能です。このファイルは、インスタレーション
ディレクトリに格納されています。

以下の例に従って、デフォルト設定を変更してください。

コンフィギュレーションファイルをカスタマイズする：

• install.iniファイルをテキストエディタで開きま
す。

以下は、この INI ファイルのデータの一例です。

;Sets the main directory of ASCET

;MainDir=c:¥etas¥ASCET6.1

• デフォルト設定を修正するには、MainDirキーワー
ドの行の “;”（コメントを示す）を削除します。

• パスを、たとえば

H:¥programs¥etas¥ASCET6.1というように変更し
ます。

ファイルの内容は、以下のようになります。

;Sets the main directory of ASCET

MainDir=H:¥programs¥etas¥ASCET6.1

• install.iniの他の部分も、同じ方法で適宜変更
します。
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• 変更内容を保存してから、エディタを閉じます。

これで、ASCET.exeを実行してインストールを開始すると、ダイアログボックス
には新しい設定がデフォルトオプションとして表示されるようになります。

インストールの連続実行

install.ini内の AutoInstallXXというパラメータを使用して、インストー
ルの終了後に 50 個以内の別のソフトウェアが連続してインストールされるようにす
ることができます。

複数のソフトウェアを連続的にインストールする：

• テキストエディタでinstall.iniファイルを開きま
す。 

インストールの連続実行を行うには、以下のパラメー
タを有効にします。

;AutoInstall01=..¥Installation2¥Install.EXE

;AutoInstall02=

• この機能を有効にするために、AutoInstall01パ
ラメータの行の先頭の “;”（コメント行を意味しま
す）を削除します。

• 連続して自動実行したいインストールプログラムファ
イルとそのパスを、たとえば

..¥..¥HTMLInstall¥setup.exeというように
設定します。

ここでは、必ず ASCET のインストールファイルとは
異なるパスを相対パスで入力してください。“..¥”
は、1 レベル上のディレクトリレベルを意味します。

AutoInstall01=..¥..¥HTMLInstall¥setup.exe

• さらに、必要に応じて自動実行するインストールプロ
グラムを順に登録します（AutoInstall10まで設
定できます）。

• 変更した内容を保存します。

インストール情報のロギング

ネットワークドライブからインストールを行うと、インストールの記録として、
ユーザー登録ダイアログボックスで入力された情報がユーザー情報ファイル

（ASCET[_*].usr）に保存されます。この情報は、社内での管理用データとして
ご使用いただけます。デフォルト状態においては、このファイルはインストール処
理を開始したインストールドライブ上の Userという名前の専用ディレクトリに格
納されます（例、F:¥User¥ASCET.usr）。

この格納場所は、前述のように、install.iniの内容を変更することによって任
意に指定することができ、またロギング機能自体を無効にすることもできます。

注記

パス設定の変更により、以下のようなカスタムインストールが可能です。

注記

登録情報がこのファイルに書き込まれるようにするためには、すべてのユーザー
にログディレクトリ、つまりインストールプログラムが格納されたディレクトリ
または install.iniで指定されたディレクトリ（以下を参照してください）
への書き込みアクセス権があることを確認してください。
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ユーザー登録情報を記録するディレクトリを指定する：

• テキストエディタでinstall.iniファイルを開きま
す。

• [Network-Preferences]セクションを内の

NetUserLoggingパラメータを有効（true）また
は無効（false）に設定します。

NetUserLogging=true

または

NetUserLogging=false

• 登録情報を記録するファイルが格納されるディレクト
リを変更するには、以下のパラメータを設定します。

;NetUserLogPath=i:¥User

• NetUserLogPathパラメータを有効にするため、こ
の行の先頭の “;”（コメント行を意味します）を削除
します。 

• パスを以下の例のように（x:¥UserLog）変更しま
す。

NetUserLogPath=x:¥UserLog

• 変更した内容を保存します。

インストールプログラムがローカルハードディスク上にある場合、デフォルト状態
においてはインストールログは作成されません。ローカルインストールの履歴を保
存したい場合は、上記の方法でコメント文字を削除し、パスを指定します。

ライセンスの運用方法

install.iniファイルの [Licensing]セクションでは、ASCET および他の

ETAS ソフトウェアプログラム使用時におけるライセンスへのアクセス方法を指定で
きます。

ライセンスへのアクセス方法を指定する：

• テキストエディタでinstall.iniファイルを開きま
す。

• [Licensing]セクション内のパラメータを設定しま
す。このセクション内で使用できるパラメータについ
ての説明は以下に示されています。

• 設定を保存します。

ここで使用できるパラメータは以下のとおりです。

• LicensingFileName

追加するライセンスファイルの絶対パスを設定します。

• LicenseToBorrow

ライセンスサーバーからライセンスを借用できる場合、このパラメータを使
用して借用メカニズムについて設定することができます。借用メカニズムを
有効にするには、ここに製品または機能のライセンス名（例： ASCET）を指
定します。2 つ以上のライセンスを指定するには、各ライセンス名をスペー
スで区切って入力してください。

• BorrowExpiryMode

借用期限の定義方法を選択します。

－ Date

借用期間は、BorrowExpiryDateで指定された日付に満了します。
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－ Interval

借用期間は、BorrowExpiryIntervalで指定された日数を経過した
時点で満了します。

• BorrowExpiryDate

BorrowExpiryModeが Dateに設定されている場合、このパラメータで
借用期間の終了日を指定します。

• BorrowExpiryInterval

BorrowExpiryModeが Intervalに設定されている場合、このパラメー
タで借用日数を指定します。

• ExecuteBorrowAutomaticExtensionInterval

借用期間を自動延長するタイミングを指定します。借用期間の残日数がこの
パラメータで設定された日数になると、

BorrowAutomaticExtensionIntervalで指定された日数だけ自動的
に期間が延長されます。

• BorrowAutomaticExtensionInterval

借用期間を自動延長する日数を指定します。延長するタイミングは

ExecuteBorrowAutomaticExtensionIntervalで指定します。

• ImmediateBorrow

ライセンスの自動借用について行われるようにするかどうかを指定します。

－ True

インストール時に自動的にライセンスの借用が行われます。

－ False

プログラムが初めてライセンスサーバーに接続した際にライセンスの借用
が行われます。

• CustomLicenseFolder

追加されるライセンスファイルのデフォルトの格納場所（C:¥Documents 
and Settings¥All Users¥Application Data¥ETAS¥FlexNet）
に管理者権限を持つユーザーしか書き込みできない場合、このパラメータで
別のパスを指定することができます。

以下の例のように設定すると、ASCET においてライセンス借用が有効になります。

ASCET の初回起動時にライセンスの借用が行われ、デフォルト状態においては 100 
日後に借用期間が終了します。

[Licensing]

LicenseFileName = 'd:¥licenses¥MyLicense.lic'

LicensesToBorrow = 'ASCET-MD'

BorrowExpiryMode = 'Interval'

BorrowExpiryInterval = '100'

ImmediateBorrow = 'false'

自動インストール

ASCET.exe ¥sというコマンドを実行すると、ASCET のインストールがバックグ
ラウンドで完全に自動実行されます。ユーザーの介入は一切必要なく、その時点で
有効なデフォルト設定が自動的に選択されます。install.iniファイル内の各デ
フォルト設定は任意に変更できます（23 ページの「インスタレーションダイアログ
のカスタマイズ」を参照してください）。
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システム管理者が “ASCET.exe ¥s”コマンドを含むバッチファイルを作成し、

install.ini内の必要な設定を行えば、ユーザーはこのバッチファイルを実行す
るだけで、一切の入力作業なしにインストール作業を実行できるようになります。

なおこのインストール方法においてはダイアログボックスはまったく表示されない
ので、インストールが完了した時点でユーザーに通知を行うメカニズムを用意して
おくとよいでしょう。

2.2.4 項「コマンドラインからのインストール」（21 ページ）も参照してください。

ASCET ファイルのカスタマイズ

以下に説明するようなカスタマイズ機能を利用してインストールプログラムを調整
し、インストール実行時にカスタマイズされたファイルをデフォルトファイルに上
書きしたり、他のファイルをインスタレーションセットに含めたりすることができ
ます。

この機能によって、カスタマイズされたデータベース、ユーザープロファイル、
ウィンドウテンプレートなどをインストールプログラムに統合することが可能とな
ります。

このためには、ソースディレクトリ下に InstData¥...というサブディレクトリ
を作成し、正しいディレクトリ構造を維持しながらカスタムファイルをそこにコ
ピーします。

カスタムファイルを作成するには、まず ASCET をテスト用 PC にインストールし、
これを用いてファイルを作成します。

ASCET のデフォルトインストールを行うと、ETASData¥ASCET6.1¥...ディレ
クトリに以下のようなサブディレクトリが作成されます。そこには ASCET のデフォ
ルト設定を定義するファイルがあり、それらをカスタマイズすることが可能です。

• Database¥DB¥

DBサブディレクトリには、デフォルトのデータベースが格納されています。
ここに、たとえば Database¥DemoDB¥といった別のデモ用データベースを
作成できます。

• User¥[user name] - Windowsのログインユーザー名により異なる

[user name]サブディレクトリには、デフォルトのユーザープロファイル
が格納されます。設定可能なオプションはすべて、このサブディレクトリに
保存されます。

ネットワークインスタレーション用のデータをカスタマイズする：

• ASCET を PC にインストールします。

• ASCET を起動します。

• ユーザープロファイルを修正します。

• データベースを修正するか、新しいデータベースを追
加します。

• ASCET を終了します。

ここまででカスタマイズは終了したので、これらのファイルをインスタレーション
プログラムに統合します。次の 2 通りの方法があります。

• 同じ名前の既存のファイルにカスタムファイルを上書きします。これを行う
ためには、InstData¥overwrite¥というフォルダをソースディレクトリ
に作成しておく必要があります。

• カスタムファイルの名前を変更して、それらを既存のファイルに追加します。
同じ名前のファイルは上書きされません。これを行うためには、

InstData¥add-only¥というフォルダをソースディレクトリに作成してお
く必要があります。
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カスタムファイルをインスタレーションプログラムに含める場合、必ずその親ディ
レクトリもコピーしてください。ETASData¥ASCET6.1¥ディレクトリのレベル
は、 InstData¥overwrite¥や InstData¥add-only¥と同じでなければな
りません。

例：

InstData\overwrite\user\userdefaultSettings.xml

InstData\add-only\database\additionalDB\

変更済みのユーザープロファイルを統合する：

• カスタマイズした
ETASData¥ASCET6.1¥user¥[user 
name]¥userSettings.xml ファイルを

InstData¥overwrite¥user¥サブディレクトリ
にコピーします。

• userSettings.xmlファイルの名前を

userdefaultSettings.xmlに変更します。

これで、インストール後は、新規のユーザー用として
この初期化ファイルが使用されるようになります。

変更を加えたデータベースを統合する：

• カスタマイズしたデータベース、つまり

¥database¥DB¥ サブディレクトリを

InstData¥add-only¥...サブディレクトリにコ
ピーします。

• DBディレクトリの名前を任意に変更します。変更し
ないとデータベースはコピーされません。

もちろん、InstData¥overwrite¥ディレクトリ
を用いて DBデータベースを上書きすることもできま
す。

上記のように設定した後にインストールルーチン（ASCET.exe）を起動すると、
デフォルトファイルはカスタムファイルで上書きされ、対応するディレクトリに新
しいファイルが追加されます。
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2.4 ASCET ディレクトリ

ASCET をインストールすると、インストール先のディスクに以下のディレクトリ構
造が生成されます（インストール時に別のパスを指定することもできます）。

2.4.1 デフォルトのデータディレクトリ

• データベース
ETASData¥ASCET6.1¥Database

• ワークスペース
ETASData¥ASCET6.1¥Workspace

• エクスポート
ETASData¥ASCET6.1¥Export

• インポート
ETASData¥ASCET6.1¥Export

• 生成されるコード
ETAS¥ASCET6.1¥CGen 

• 自動生成されるドキュメント

ETASData¥ASCET6.1¥Docu（ドキュメント生成時に作成されます）

2.4.2 デフォルトディレクトリの変更

ASCET の “Options” ダイアログボックスで、データディレクトリのデフォルト設定
を変更することができます。以下のように操作してください。
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データディレクトリのデフォルト設定を変更する：

• ASCET のコンポーネントマネージャからメニューコ
マンド Tools → Options を選択します。

“Options” ダイアログボックスが開きます。各デデー
タパスのデフォルト設定は、以下のノードで行いま
す。

データベース／ワークスペース： “Options”
エクスポート： “Integration/Export”
インポート： “Integration/Impot”
コード生成： “Build”
ドキュメント： “Documentation"

• 変更したいパスの右側のボタンをクリックします。

“Path selection” ダイアログボックスが開きます。

• デフォルトディレクトリとして使用したいディレクト
リを指定します。

• OK をクリックします。

指定されたディレクトリが “Options” ダイアログ
ボックスに表示されます。

• 変更したいすべてのオプションについて、以上の手順
を繰り返します。

• 設定が終了後、OK をクリックすると設定内容が確定
され、Cancel をクリックすると取り消されます。

2.5 ASCET のアンインストール

ASCET をアンインストールすると、インストールされている ASCET 製品すべてが
自動的にアンインストールされます。各 ASCET ファミリ製品（ASCET-MD、

ASCET-SE、ASCET-RP など）やアドオン製品（ASCET-DIFF を除く）を個別にアンイ
ンストールすることはできません。

ASCET のアンインストール処理は、以下のいずれかの方法で起動できます。

1. Windows コントロールパネルから プログラムの追加と削除 を選択します。

2. Windows スタートメニューのプログラムグループ ASCET6.1 から Uninstall 
を選択します。
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2.5.1 自動アンインストール

ASCET を自動モードでアンインストールする：

• ASCET のアンインストール処理を起動します。

以下のダイアログボックスが開きます。

• Automatic を選択します。

• Next ボタンをクリックします。
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• アンインストールを実行するには Finish ボタンをク
リックします。

アンインストール実行中にアンインストール処理を中止することもできます。

Cancel ボタンをクリックすると、以下のダイアログボックスが開きます。

2.5.2 カスタムアンインストール

ASCET を手動モードでアンインストールする：

• ASCET のアンインストール処理を起動します。

以下のダイアログボックスが開きます。

• Custom を選択します。

注記

キャンセルした時点でデータがすでに消去されていた場合は、ASCET を再インス
トールする必要があります。
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• Next ボタンをクリックします。

“Select Private Files to Remove” ダイアログボックス
が開きます。

• “Select Private Files to Remove” ダイアログボックス
で、削除したいファイルを選択します。

• Next ボタンをクリックします。

• “Select Directories to Remove” ダイアログボックス
で、削除したいディレクトリを選択します。

• Next ボタンをクリックします。

• “Select INI Files to Remove” ダイアログボックスで、
削除したい *.iniファイルを選択します。

• Next ボタンをクリックします。

• “Select INI Items to Edit” ダイアログボックスで、編
集したい *.iniファイルを選択します。

• Next ボタンをクリックします。

• “Select Registry Keys to Remove” ダイアログボック
スで、削除したいレジストリキーを選択します。

• Next ボタンをクリックします。

• “Select Registry Trees to Remove” ダイアログボック
スで、削除したいレジストリフォルダを選択します。

• Next ボタンをクリックします。

• “Select Registry Keys to Edit” ダイアログボックスで、
編集したいレジストリキーを選択します。

• Next ボタンをクリックします。

• “Select Sub-Systems to Remove” ダイアログボックス
で、削除したいサブシステムを選択します。

• Next ボタンをクリックします。

• “Perform Uninstall” ダイアログボックスで、Finish
ボタンをクリックします。

アンインストールが実行されます。
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カスタムアンインストール実行中でも、自動アンインストールの場合と同様に

Cancel ボタンでアンインストールを中止することができます。

注記

キャンセルした時点でデータがすでに消去されていた場合は、ASCET を再インス
トールする必要があります。
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3 ソフトウェアのライセンス管理

ETAS のソフトウェア製品を使用するにはライセンスが必要です。本項ではライセン
ス管理について詳しく説明します。

• ETAS のライセンスモデル（35 ページ）

• ライセンスの取得（35 ページ）

• ライセンスファイル（36 ページ）

• グレースモード（39 ページ）

• 「有効期限についての警告」ダイアログボックス（39 ページ）

• ライセンスの借用（40 ページ）

各ライセンスの適用範囲やその他の条件については、ソフトウェア製品の使用条件
に関するドキュメントをご参照ください。このドキュメントはソフトウェア製品に
同梱されています。

3.1 ETAS のライセンスモデル

ETAS ソフトウェアのライセンスには 3 種類のライセンスモデルがあります。

マシンネームライセンス （ローカル）

• 特定の PC を対象としたライセンスで、ライセンス管理は PC のユーザー自身
が行います。

• ライセンスは特定の PC にリンクするので、その PC を使用すればいつでもラ
イセンスを使用できます。

• PC を交換する際は新しいライセンスを発行する必要があります。

ユーザーネームライセンス （サーバーベース）

• 部門または会社を対象としたライセンスで、指定された管理者がサーバー上
でライセンスを集中管理します。

• ライセンスはネットワークに登録されたユーザー名にリンクするので、ネッ
トワーク内のどの PC からもライセンスを使用できます。

• PC をネットワークから切断してオフラインで使用する際は、ライセンスを
「借用」する必要があります。

コンカレント（または「フローティング」）ライセンス （サーバーベース）

ユーザーネームライセンスと同様のものですが、ここでは複数のユーザーが決めら
れた数のライセンスを共有できます。

3.2 ライセンスの取得

社内で ETAS ソフトウェアのサーバーベースライセンス管理を行っている場合、ライ
センスの取得についてはサーバーの管理者の方にお問い合わせください。その他

（マシンネームライセンス）の場合は、ETAS ライセンスポータル（URL は製品に同
梱されたドキュメントに記載されています）からライセンスを取得してください。
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ライセンスポータルへのログイン方法には以下の 3 通りがあります。

• アクティベーション ID でログインする

ログインすると「アクティベーション」1 が表示され、これを管理することが
できます。アクティベーション ID は製品に添付されたライセンスドキュメン
トに記載されています。

• エンタイトルメント ID でログインする

エンタイトルメント2 に関連付けられたすべてのアクティベーションが表示
され、これらを管理することができます。この方法は、部署や会社単位で 1
つのエンタイトルメントを使用するような場合に便利です。

• E メールアドレスとパスワードでログインする

ユーザーアカウントに割り当てられたすべてのアクティベーションとエンタ
イトルメントが表示され、それらを管理することができます。この方法は、
ツール管理者の方が複数のエンタイトルメントを管理するような場合に便利
です。

ライセンスポータルの使用方法がわからない場合は ヘルプ というリンクをクリック
してヘルプドキュメントを開いてください。

必要な情報

ライセンスをアクティベート（= 有効化）するには、使用する PC についての以下の
情報が必要です。

• マシンネームライセンス

ライセンスを結び付けるイーサネットアダプタの MAC アドレス

• ユーザーネームライセンス

サーバーホストまたはサーバートライアド、およびユーザー名

• コンカレント（フローティング）ライセンス

サーバーホストまたはサーバートライアド

3.3 ライセンスファイル

ライセンスポータルでライセンスが発行されると <name>.Licというライセンス
ファイルが生成されるので、このファイルを ETAS ライセンスマネージャで PC に登
録します。

1. 「アクティベーション」には、特定の製品とそのライセンス条件、ライセンス数など、
ライセンス発行に必要な情報が割り当てられています。各アクティベーションは、「ア
クティベーション ID」によって識別されます。

2. 「エンタイトルメント」は、ある製品について 1 つまたは複数のライセンスを保持する
ためのユーザー権限を表すものです。つまりエンタイトルメントはソフトウェアを使用
する権利の「口座」のようなもので、ここから必要に応じてライセンスを取り出すこと
ができます。

注記

PC ハードウェアやユーザーの変更に伴い上記の情報が変更された場合は、ライセ
ンスを「リホスト」する必要があります。この方法はライセンスポータルのヘル
プドキュメントに記載されています。
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ライセンスのインストール状態を調べる：

• Windows スタート メニューから ETAS → License 
Management → ETAS License Manager を選択し
ます。

または

• ASCET のコンポーネントマネージャから Help → 
License Info を選択します。

• 続行 をクリックします。

ETAS ライセンスマネージャが開き、インストールさ
れている ASCET 製品のライセンス情報が表示されま
す。各エントリ行の先頭の列のシンボルと “ ステータ
ス ” 列に表示されるテキスト情報で、有効なライセン
スがインストールされているかどうかがわかります。
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ライセンスを追加する：

• ETAS ライセンスマネージャを開いて（37 ページ参
照）、ファイル メニューから ライセンスファイルの追
加 を選択します。

“ ライセンスのインストール ” ダイアログボックスが
開きます。

• “ ライセンスファイルの選択 ” フィールドの右側にあ
る ... ボタンをクリックします。

• ファイル選択ダイアログボックスで、ライセンスファ
イルを選択して 開く をクリックします。

“ ライセンスのインストール ” ダイアログボックス
に、選択されたライセンスファイルの情報が表示され
ます。

• OK をクリックしてライセンスファイルをインストー
ルします。

上記の操作で選択されたライセンスの情報が、ETAS
ライセンマネージャに反映されます。エントリの先頭
部分には、ライセンスが有効であることを示す緑の
チェックマークシンボルが表示されます。

• 閉じる をクリックして ETAS ライセンスマネージャを
閉じます。

注記

上記ダイアログボックスの “ バージョン ” 列に表示さ
れる番号は、ライセンスのバージョン番号で、ソフト
ウェアのバージョン番号とは異なります。
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3.4 グレースモード

ライセンスをインストールしていなくても、一定の期間のみ「グレースモード」で
ソフトウェアを使用することができます。その期間はソフトウェア起動時に以下の
ウィンドウが開き、グレースモードで使用できる残日数が表示されます。

3.5 「有効期限についての警告」ダイアログボックス

インストールされているライセンスの有効期限が 30 日以内になると、ETAS ソフト
ウェアを開く際に警告メッセージが表示されます。

「有効期限についての警告」ダイアログボックスには、30 日以内に有効期限が切れ
るライセンスの一覧が表示されます。各ライセンスごとに期日が表示され、借用ラ
イセンス（40 ページ「ライセンスの借用」 参照）の場合は借用期限（借用モードが
終了する期日）も表示されます。

ここで有効なライセンスファイルをインストールするには、ライセンスの管理 ボタ
ンをクリックして ETAS ライセンスマネージャを開いて所定の操作（38 ページ「ラ
イセンスを追加する：」 参照）を行ってください。有効なライセンスがインストール
された後は、そのまま継続して ETAS ソフトウェアを使用できます。

ライセンスファイルをインストールせずに ETAS ソフトウェアを使用するには、今は
何もしない をクリックします。この操作は、グレースモード期間内でのみ可能です。
グレースモードの期間が終了すると、有効なライセンスファイルをインストールす
るまで ETAS ソフトウェアは使用できなくなります。

ライセンスの有効期限が切れた場合は、さらに 14 日間継続して制限付きで ETAS ソ
フトウェアを使用することが可能ですが（39 ページ「グレースモード」 参照）、この
期間が過ぎると、新しいライセンスまたは更新されたライセンスをインストールす
るまで ETAS ソフトウェアは使用できなくなります。
ソフトウェアのライセンス管理 39



40
3.6 ライセンスの借用

サーバーライセンスを使用している場合、ライセンスの「ボロー」メカニズムを利
用することにより、オフライン（ライセンスサーバーに接続しない状態）で ETAS ソ
フトウェアを使用することができます。

ライセンスの借用は以下のように行います。

ライセンスを借用する：

• ライセンスを借用したい ETAS ソフトウェアが、現在
起動されていないことを確認します。

• ETAS ライセンスマネージャ ウィンドウの “ ライセン
スリスト ” フィールドから、借用したいライセンスを
選択します。

• ライセンス メニューから ライセンスの借用 を選択し
ます。

“ 借用期限の設定 ” ダイアログボックスが開きます。

• カレンダーで、ライセンスを借用する期限を指定しま
す。

注記

ライセンスの借用ができるのはサーバーベースライセンスの場合のみです。
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• OK をクリックします。

ETAS ライセンスマネージャ ウィンドウの “ ソース ”
列の表示が “ サーバー ” から “ 借用 ” に変わり、借
用期限の日付が表示されます。

これで、ETAS ソフトウェアを借用期限までオフラインで使用できるようになりまし
た。

指定した借用期限を超えて ETAS ソフトウェアを使用する必要が生じた場合は、再度
ライセンスを借用してください。指定した借用期限前に ETAS ソフトウェアの使用を
終了する場合は、ライセンスを期限前に返却（ライセンス → ライセンスを期限前に
返却）することができます。ライセンスの返却は、それを借用したユーザーしか行
えません。他のユーザーによる返却は行えません。 
ソフトウェアのライセンス管理 41
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4 お問い合わせ先

製品に関するご質問等は、各地域の ETAS 支社までお問い合わせください。

ETAS 本社

ETAS GmbH

日本支社

イータス株式会社

その他の支社

上記以外の各国支社につきましては、ETAS ホームページをご覧ください。

Borsigstrasse 14 Phone: +49 711 89661-0

70469 Stuttgart Fax: +49 711 89661-106

Germany WWW: http://www.etas.com/

〒 220-6217 Phone: (045) 222-0900

神奈川県横浜市西区 Fax: (045) 222-0956

みなとみらい 2-3-5 E-mail: sales.jp@etas.com

クイーンズタワー C 17F WWW: http://www.etas.com/

各国支社 WWW: http:://www.etas.com/ja/contact.php

技術サポート WWW: http://www.etas.com/ja/hotlines.php
お問い合わせ先 43
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